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Abstract
The model of enterprise architecture (EA) is often a primary means of steering the business-IT development. It helps to
ensure EA qualities in many ways, including identification of weaknesses in an EA or the signs thereof. Such weaknesses
have been addressed through the study of EA smell, which focuses on common bad habits in EA practices. Although EA
smell problems have been described in various contexts, current solutions lack the basis of evidence and practical details that
are necessary for their adoption. Therefore, this study seeks to gain new insights into the solution domain of EA smells by
exploring current knowledge about refactoring solutions. We present our findings in a catalog of EA refactoring solutions
intended to serve as food for thought for future research directions.
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1. Introduction
The model of enterprise architecture (EA) greatly sup-
ports sustainable management of complex IT landscapes.
It provides insights into the current implementations and
future orientations of the EA developed, thereby provid-
ing a reasoning basis for important decisions. Neverthe-
less, the maintenance of the EA model is often pushed
down the priority list due to, e.g., lack of resources or
supporting methods. Flaws and deficiencies in the EA
may remain ignored and create barriers to EA evolution
known as EA debt [1]. To prevent such tendencies, prac-
tical methods for supporting the continuous evaluation
and improvement of EA models are needed.

Using EAmodels to guide the improvement of EA qual-
ities has been proposed by some studies. Salentin and
Hacks coined the concept of EA smell to address common
bad habits in EA practices and derived EA smells [2] by
transferring known code smells into the context of EA.
Lehmann et al. made a similar attempt to derive process
modelling anti-patterns for EA analyses [3] by transfer-
ring known workflow anti-patterns into the context of
EA. Both of these studies suggest, among others, some so-
lutions to refactor the problems they identify. However,
existing descriptions of these solutions lack the basis of
evidence and practical details that are necessary for their
application. This study therefore focuses on exploring
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current knowledge about refactoring solutions to find
further evidence about EA refactoring solutions and new
ways of approaching them.

Considering that current EA smells were derived from
code smells, we argue that exploring known code refac-
toring solutions can result in meaningful insights into
the refactoring solutions for EA smells. Therefore, based
on the code smells used in EA smell studies, we first
searched for relevant code refactoring solutions in major
code smell and refactoring catalogs. The code refactor-
ing solutions collected were then used to answer the
following research questions (RQ):

RQ 1 What EA refactoring solutions can be derived
from the existing code refactoring solutions?

RQ 1.1 How to derive insights about EA refactoring
from analyzing code refactoring solutions?

RQ 1.2 What attributes can describe an EA refactoring
solution?

RQ 2 How can EA practitioners and researchers benefit
from knowing about EA refactoring solutions?

The remainder of this paper is structured as follows:
Section 2 gives an overview of studies related to refac-
toring solutions. Section 3 describes our methodology
for deriving and documenting refactoring solutions for
EA smells. Section 4 presents the resulting EA refactor-
ing solutions mapped to the corresponding EA smells.
Section 5 demonstrates some small practical examples of
using EA refactoring solution for mitigating EA smells.
Section 6 discusses our finding, its implications, and the
threats to its validity. Section 7 motivates future research
directions and concludes this paper.
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2. Related Work
The concept of refactoring has been developed to sup-
port software design and evolution, specifically to rec-
tify design flaws and improve software quality through
restructuring plans while preserving the observable be-
havior. The term ’refactoring’ can be used in different
ways, namely ’refactoring’ (noun) to mention the restruc-
turing applied to a software [4], ’to refactor’ (verb) to
mention the activity of restructuring a software [4], or
’refactoring solution’ to mention a possible technique for
restructuring a software (e.g. [5]). For the sake of clarity,
these ways of usage are applied in this paper.

After being extensively used in programming domains,
such as the procedural programming (e.g. [6]), object-
oriented programming (e.g. [5]), and functional program-
ming (e.g. [7]), the concept of refactoring has been ex-
plored in a wider spectrum of software engineering. In
the domain of software modelling, the concept of model
refactoring was introduced to enable restructuring plans
on the high-level description of software [8]. The aim of
model refactoring can be twofold: to allow for an earlier
(i.e. at the design stage) and easier (i.e. reduced com-
plexity) refactoring of software; or to improve semantic
and syntactic quality measures of the model. Whichever
aim is set, model refactoring should preserve both the
behavior of the modelled software and the semantic of
the model.

Studies of model refactoring have varied in their focus,
whether it be on a specific modelling language or par-
ticular architectural aspect. Modelling languages such
as the object constraint language (OCL), unified mod-
elling language (UML), and web ontology language have
been studied and supported with designated refactoring
solutions [9] [10] [11]. Architectural aspects such as
process aspect, data aspect, and style aspect have also
been analyzed in this context to support a comprehensive
architecture restructuring [12] [13] [14]. Furthermore,
the so-called large refactorings have been proposed to
deal with refactoring in complex projects, specifically
when changing significant parts of a system, which often
takes longer than a day [15]. Still, there are growing
possibilities to explore new refactoring solutions for new
design anomalies, especially with the growing interest in
bad smell research—which focuses on detecting concrete
indication of the need for refactoring [4].

The concept of bad smell has been adopted in the do-
main of EA and referred to as EA smell, which represents
negative examples and bad habits that, when ignored,
may harm the performance of EA activities or even the
organization as a whole [2]. The concept was proposed
together with a catalog of 45 EA smells, which describes
(among others) the problem contexts, applicable detec-
tion methods, and possible mitigation solutions. Based
on the scope of occurrence, an EA smell can be of the busi-

ness, application, and/or technology architecture. This
scope was recently expanded by the exploration into EA
process anti-pattern, which resulted in 18 EA smells for
process-related issues [3]. As the interest in EA smell
research is growing, more EA smells will continue to be
identified through new explorations into other aspects
of EA, such as management.

3. Methodology
This study uses the design science research (DSR)method-
ology according to the guidelines proposed by Peffers
et al. [21] and Hevner et al. [22]. A DSR aims to devise
an artifact that addresses a ”heretofore unsolved and im-
portant business problem” by drawing on the existing
knowledge, and the resulting artifact must be rigorously
evaluated in terms of its ”utility, quality, and efficacy” and
effectively communicated to relevant audiences. With
respect to the DSR guidelines above, this study follows
the six main steps of DSR as listed below.

1. Problem identification and motivation. Define
the specific research problem and justify the value of
the solution proposed

2. Solution objective definition Infer the objectives
of the solution proposed from the problem definition
and knowledge of what is possible and feasible

3. Design and development. Create the artifact

4. Demonstration. Demonstrate the use of the artifact
to solve one or more instances of the problem

5. Evaluation. Observe and measure how well the arti-
fact supports a solution to the problem

6. Communication. Communicate the problem and
its importance, the artifact, its utility and novelty, the
rigor of its design, and its effectiveness to researchers
and other relevant audiences

The following subsections describe the process and meth-
ods employed in this study with respect to the steps
above.

3.1. Problem identification and
motivation

Despite current results in EA smell research (as presented
in section 2), the identification of EA smells is never an
end in itself. The identified EA smells should, e.g., in-
form the decisions for imposing suitable EA improvement
measures with regards to the current circumstances and
interests. To reason such decisions, enterprise architects
need to first understand the applicability of each solu-
tion alternative through evidence and practical details,
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UML→ArchiMate Source

Activity→ Interaction, Function, Pro-
cess

[16, 17, 18]

Actor→Actor, Role [19, 16, 17, 20]
Artifact→Artifact, Contract, Deliver-
able, Gap, Product, Representation

[19, 16, 17, 20]

Association→Association, Aggregation,
Composition

[17, 20, 18]

Class→Actor, Collaboration, Compo-
nent, Data Object, Meaning, Motiva-
tional Concepts, Object, Plateau, Repre-
sentation, Role, Stakeholder, Value

[19, 16, 20, 18]

Collaboration→Collaboration, Func-
tion, Interface, Location

[19, 16, 17, 20,
18]

Component→Component, Grouping [19, 16, 17, 20]
Communication Path→
Communication Path, Network

[17, 20, 18]

Dependency→Assignment, Derived, In-
fluence, Serving/Used by

[17, 20]

Device, Event, Execution Environ-
ment→Device, Event, System Software

[19, 16, 17, 20]

Generalization→ Specialization [19, 20, 18]
Information Flow→ Flow, Triggering [20]
Interaction→ Interaction, Application
Service, Event, Function, Process

[16, 18]

UML→ArchiMate Source

Interface→ Interface, Service [19, 16, 17, 20,
18]

Method→Application/Infrastructure
Function, Infrastructure Service

[16]

Note/Comment→Meaning, Represen-
tation

[18]

Node→Node, Communication Path, De-
vice, Infrastructure Interface, Location,
Network, System Software

[19, 16, 17, 20]

Object→Object, Contract, Data Object,
Meaning, Product, Representation, Value

[16]

Opaque Behavior→Application Inter-
action, Business Event, Business Interac-
tion, Business Process, Junction, Work
Package

[20]

Swimlane→Actor, Business Service,
Role

[16]

Usage→Access, Serving/Used By [20]
Use Case→Business Function, Business
Interaction, Requirement, Service

[19, 16, 17, 20]

Realization, Composition, Aggrega-
tion→Realization, Composition, Aggre-
gation

[19, 17, 20, 18]

Table 1
A mapping from UML to ArchiMate

which are still lacking in the hitherto solution suggestions
for EA smell mitigation. Furthermore, current knowl-
edge about the refactoring of architectural smells focuses
on rather technical aspects (i.e. software architecture),
which are hardly applicable for evaluating and evolv-
ing an EA. Therefore, we argue that EA research should
pursue the identification of possible EA refactoring so-
lutions to guide enterprise architects in finding possible
and feasible solutions for the EA smell problems at hand.

3.2. Solution objective definition
Considering the problem described above, this study aims
to devise the concept of EA refactoring solution by draw-
ing on the existing knowledge about refactoring. To
guide the solution design and development, this study
sets the following solution objectives:

1. Support enterprise architects in finding appropriate
solutions to a certain EA smell by identifying possible
EA refactoring solutions and providing clear descrip-
tions about their context and implementation

2. Support enterprise architects in communicating rele-
vant EA refactoring solutions in a consistent manner
by identifying relevant attributes and providing a stan-
dard documentation template

3. Allow the EA community to obtain an up-to-date
overview of results in EA refactoring research and
contribute to the its development

3.3. Design and development
Since the first EA smells were derived from code smells
[2], we assume that refactoring solutions for code smells
may hold some clue to the refactoring solutions for EA
smells. This assumption leads to the design of ourmethod-
ology, which includes three main steps: Concept analysis,
concept mapping, and concept transformation.

Concept Analysis. Our first step is to collect relevant
code refactoring solutions for the code smells used by
existing studies on EA smells [2]. Our analysis covered
some existing code smells or anti-patterns catalogs (i.e.,
[4], [23], and [24]). Whilewe are aware that ”the presence
of code smells does not imply the presence of architec-
tural smells and vice versa,” [25], we argue that some
problematic design patterns addressed by code smells
or anti-patterns (e.g. cyclic dependency or duplication)
may also occur in EA context. Furthermore, the practice
of transferring existing concepts into a different domain
has been performed to generate first ideas within a new
problem domain and inspire further research (e.g. [2],
[3]).
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Attribute Meaning

Name Gives the refactoring solution a meaningful designator
Connected EA Smells Links the refactoring solution to the targeted EA smells
Derived from Names the code refactoring solution from which this refactoring solution is derived
Summary Gives a brief overview of this refactoring solution
Intent Describes the main goal of this refactoring solution
Motivation Describes the reasons of applying this refactoring solution
Prerequisites Describes the conditions prior to applying this refactoring solution
Impact Describes the influence of this refactoring solution to EA qualities
Mechanics Describes the practical steps to apply this refactoring solution
Discussion Describes the situations when this refactoring solution can be useful
Graphical example Shows a graphical representation of the refactoring solution to reduce misinterpretations

Table 2
Attributes of EA refactoring solutions (adapted from [4], [26], and [27]).

Concept Mapping. The second step in our method-
ology is to establish a mapping between the concepts in
code and EA modelling, which should serve as a basis for
conceptually transforming the code refactoring solutions
collected into EA refactoring solutions.

Although the code and the EA lie on two opposite sides
in the spectrum of abstraction, the languages used for
modelling them share a good deal of similar constructs in
that both support the description of architectural aspects.
Previous studies have proposed some mappings between
the notations of UML and ArchiMate, which are the most
used languages for code and EA modelling, respectively.
Some of these mappings are described in the ArchiMate
specification [17]—as some notations thereof are indeed
derived from UML [19]—, while the rest have been exclu-
sively suggested by the studies. Since most code refactor-
ing solutions have been described and exemplified using
UML, we strongly argue that such mappings can guide
the transformation of code refactoring solutions into EA
refactoring solutions.

We believe that the first mapping between the con-
cepts in UML and ArchiMate was proposed by Wiering
et al. [18]. Their study focuses on identifying matching
concepts and relationships by comparing the notations
in the two languages by the properties thereof. Another
attempt was made in a study by Gill, which focuses on
finding concepts in other modelling languages beside
ArchiMate which are applicable for EA modelling [16].
The resulting contribution includes a mapping of some
concepts in UML to ArchiMate. Furthermore, Lankhorst
also advocate the use of ArchiMate in conjunction with
other modelling languages (including UML) to create a
more holistic EA description [19]. To support this in prac-
tice, this contribution highlights not only the similarities
but also important differences in ArchiMate and UML, e.g.
the absence of separate concepts for service and interface
as well as the reverse interpretation of the ArchiMate
relationship serving in UML. Lastly, another mapping

of UML and ArchiMate is proposed by Gericke, which
also considers ArchiMate concepts under the motivation
layer [20]. Table 1 summarizes all these mappings which
we use as a basis to conduct the concept transformation.

Concept Transformation. To finally derive EA refac-
toring solutions, the code refactoring solutions collected
are processed as follows:

• We analyzed the descriptions and examples of code
refactoring solutions to identify instances of UML con-
cepts and relationships. Based on the mapping of UML
and ArchiMate notations shown in table 1, the iden-
tified UML constructs are translated into ArchiMate
constructs. Since each UML notation does not neces-
sarily map exclusively with one ArchiMate notation
(e.g. both Collaboration and Interface in UML
can be translated into Interface in ArchiMate), the
translation has to be inferred rationally from our un-
derstanding of what solution is possible and feasible
for the EA smell addressed.

• In some cases, the translation may not directly result in
an ArchiMate construct that conveys a valid solution in
the context of EA. Such ArchiMate construct is either
modified for a reasonable EA refactoring solution or
excluded from consideration.

Because of the manual concept transformation in this
process, the outcome is highly influenced by the skill,
knowledge, and experience of the researchers. Also, since
the mapping used gives more than one matching Archi-
Mate notations for every UML notation, the resulting
translation may vary depending on the researcher’s own
understanding and interpretation of the two modelling
languages (UML and ArchiMate).
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EA smell→EA refactoring solutions

Ambiguous Viewpoint→ 5 Viewpoints
Architecture by Implication→Goal Question Architecture
Big Bang→Process Manager
Bloated Service→Merge input
Business Process Forever→Process Manager
Chatty Service→ Front End Gate
Combinatorial Explosion→ Extract Shared Functionality
Connector Envy→ Extract Component
Cyclic Dependency→Cyclic Dependency Removement
Data-Driven Migration→ Functionality First, Data Last
Data Service→ Encapsulate Data Service
Dead Component→Remove Dead Component
Deficient Encapsulation→Break Up Component
Deficient Names→Rename Component
Dense Structure→Complexity Reduction
Documentation→Rename Component
Duplication→ Extract Shared Functionality
Feature Envy→Move Component or Front End Gate
Golden Hammer→Boundaries
Hub-like Modularization→Break Up Component
Incomplete Abstraction→Grouping
Incomplete Node or Collaboration→ Introduce Local Exten-
sion
Inconsistent Versioning→ Semantic Versioning

EA smell→EA refactoring solutions

Jumble→Architecture Partitioning
Lazy Component→Ghostbusting or Inline Service
Message Chain→ Process Manager or Extract & Move Data
Object
Missing Abstraction→Add Abstraction
Multifaceted Abstraction→ Split Phase
Nanoservices→ Front End Gate
No Legacy→Process Manager
Nothing New→Process Manager
Overgeneralization→ Extract Shared Functionality
Sand Pile→Grouping
Scattered Parasitic Function→Merge Components
Shared Persistency→ Encapsulate Business Objects
Shotgun Surgery→Grouping
Stovepipe System→Architecture Framework or EA Planning
Strict Layers Violation→Move Service to Different Layer
Temporary Solution→ Extract Temporary Solution
The God Object→God Object Decomposition
The Shiny Nickel→Plan Ahead
Vendor Lock-In→ Isolation Layer
Warm Bodies→ Small Project
Weakened Modularity→ Split Modularity
Wrong Cuts→Reorganization

Table 3
Catalog of EA Refactoring Solutions

3.4. Demonstration
In this DSR step, the use of the artifact is demonstrated
to solve one or more instances of the problem [21]. The
fundamental questions to be answered are, ”What utility
does the new artifact provide?” and ”What demonstrates
that utility?” [22] In the context of this study, the EA
refactoring solutions proposed should provide solution
alternatives for mitigating EA smells and the practical
details needed to understand their feasibility as well as
relevance according to the current conditions. Therefore,
to demonstrate the applicability of our result for solving
the problems described in section 3.1, we illustrate some
small scenarios of mitigating EA smells using the EA
refactoring solutions proposed. For this purpose, we use
a small ArchiMate model which contains some EA smells.
Then, we identify candidates of EA refactoring solutions
and select one that we deem the most appropriate for the
EA smell given. It is worth noting that the systematic ap-
proach to prioritizing EA refactoring solution candidates
is still a subject to future work; hence, the selection of
EA refactoring solution demonstrated in this paper relies
on the authors’ perspectives. Finally, we elaborate the
architectural changes suggested by the EA refactoring
solution selected, show the resulting ArchiMate model
after applying these architectural changes, and discuss
the impact on the ArchiMate model’s overall quality.

3.5. Evaluation
The evaluation step in DSR aims to review the effective-
ness of the artifact proposed in supporting a solution to
the problem [21]. In this paper, this step is embodied in
a discussion, in which we explain how the main RQs of
this study have been answered based on our findings and
their demonstration. Since the discussion presented in
this paper is focused only on the qualitative performance
of EA refactoring solution within our example scenario,
we recommend future research to extend the evaluation
by including more (real-world) examples and quantifiable
measures (e.g. using EA model quality framework [28]).

3.6. Communication
Finally, the communication step focuses on presenting
the artifact proposed, its utility, and its effectiveness to
researchers and other relevant audiences. [21] To commu-
nicate our results in an intuitive and consistent manner,
we document the EA refactoring solutions in a standard
template (see table 2) which we adapted from some exist-
ing templates of refactoring solution used in [4] [26] [27].
Furthermore, the EA refactoring solutions are categorized
based on the domains of the corresponding EA smells
(i.e. business, technology, and application domains) [2]
and made publicly available on a web page [29].
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Name Process manager Encapsulate Business Objects
Description This refactoring increases the user orientation of service

interfaces with the goal to enable user involvement in
business processes. A process manager that realizes the
service calls is created. Previous caller of the process call
the process manager now with process control data that
parameterizes the wanted process.

Route data access through dedicated data
services that encapsulate the needed busi-
ness objects.

Connected EA
smell

Business Process Forever, Big Bang, Nothing New, No
Legacy

Shared Persistency

Derived from Process Manager Encapsulate Variable
Intent Create a process manager component which orchestrates

the components involved in the process.
Narrow down the data visibility by routing
data access through dedicated data services.

Motivation This refactoring is meant to create a better user involve-
ment. It also adds more flexibility and extensibility to the
architecture.

Reduce the likeability that teams unwillingly
depend on each other because the visibility
of the data is too broad.

Prerequisites A long, very strict process chain with many different
stakeholders involved.

Multiple business services that access the
same database.

Impact This refactoring makes the application service interfaces
more user oriented which enables the user involvement
in business processes.

The structure created by the refactoring re-
duces data visibility to only those of the
owned business objects, thereby prevent-
ing any unwanted interdependence between
teams and services.

Mechanics 1. Generate a new service P called the Process Manager
2. Add a service call from P to all the process components
of the Process manager
3. All calls to the individual process components calls
now the Process Manager with process control data C
that parameterize the wanted original Process. Test each
call individually.
4. Remove the service calls between the services that
belong now to the Process Manager P

1. Create a new data service that will contain
the dedicated data services
2. For each business service, create a dedi-
cated data service that routes the access to
the database. Test each data service.
3. Move the database into the grouping data
service.

Discussion This is not only a refactoring but also an architecture
pattern itself. It can be used to generate more online
involvement for everyone that should be involved. In
a peer-to-peer system it is usually not desired to have
many centralized services, so the process manager needs
to be evaluated carefully.

The data visibility is very narrow when using
this refactoring which reduces unwanted de-
pendencies between teams.

Table 4
Documentation of the Process Manager and Encapsulate Business Objects EA refactoring solutions

4. Result
As a result, this study yields a catalog of 37 EA refactoring
solutions for all 45 EA smells proposed in [2] (see table 3).
In the catalog, some EA refactoring solutions are sug-
gested for multiple EA smells, such as the Process Man-
ager EA refactoring solution which is suggested for the
Big Bang, Business Process Forever, Message Chain,
No Legacy, and Nothing New EA smells. Such result
is obtained because some code refactoring solutions–
from which we derived EA refactoring solutions–have
also been suggested for mitigating various code smells.
While we are aware that specific adaptations may be nec-
essary to make one kind of solution works for different
problems, the catalog currently provides only a general
description of how to apply each EA refactoring solution.
Describing such adaptations is a subject to future work.

Furthermore, the catalog also suggests multiple EA
refactoring solution candidates for some EA smells, such
as theMoveComponent and Front EndGatewhich are
suggested as solution candidates for mitigating the Fea-
ture Envy EA smell. Such result is obtained because we
identified different studies which suggest different code
refactoring solutions for the same code smell. While we
are aware that the selection of an appropriate EA refactor-
ing solution should consider the specific circumstances
surrounding the EA smell problem, such specific circum-
stances are beyond the scope of this study. Therefore, we
suggest future studies in this context to investigate the
possibility to systematically prioritize all EA refactoring
solutions recommended for a certain EA smell. In such
a prioritization approach, various quality requirements
may be considered, such as scalability and extensibility.
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Figure 1: EA refactoring demonstration, showing before (left) and after (right) refactoring EA smells in an ArchiMate model

5. Demonstrating EA Refactoring
Solutions

In order to illustrate the application of the proposed EA
refactoring solutions, we performed an experiment to ap-
ply EA refactoring solutions on a small ArchiMate model
(see fig. 1), which we adapted from [2]. This ArchiMate
model contains two EA smells: First, amessage chain due
to the sequential calls over 5 application services to fulfill
the same application process (i.e. customer registra-
tion). Second, a shared persistency because of the direct
relations between 3 application services and a database
management system (i.e. DBMS).

The first EA smell (i.e. message chain) occurs when at
least 5 services sequentially interact to fulfill a process,
which may harm availability and evolvability [30]. To
solve this, our catalog (see table 3) proposes two possi-
ble EA refactoring solutions, i.e. the process manager
(inspired from ’process manager’ in [31]) and extract
and move data object (adapted from ’extract and move
class’ in [4]). To select from several possible refactoring
solutions, the architect must first evaluate whether the
main idea and practical details thereof suit the context
of the subjected EA smell. In the presented ArchiMate
model, we assume that the exemplified message chain
does not stem from data but process architecture issues.
Therefore, the process manager is chosen, as presented
in table 4.

The chosen refactoring solution suggests to restruc-
ture the collaboration scheme between the chained ser-
vices into an orchestration scheme—in which one service
acts as a ’process manager’ that coordinates independent
services to fulfill the requested business process. This
scheme eases the maintenance and extension of the sup-
ported business process, thereby remediating the avail-
ability and evolvability issues posed by themessage chain.
In our ArchiMate model, this refactoring solution is ap-
plied by first encapsulating all involved operations across
the chained application services into independent activity

modules that are accessible through external interfaces.
Afterwards, a process manager must be implemented (in
this case, the customer information service) which re-
ceives requests for customer information processing and
fulfills these by delegating tasks to the available services.

The second EA smell (i.e. shared persistency) is de-
tected whenmultiple services access the same data collec-
tion or schema, thereby reducing team and service inde-
pendence [30]. For this, our catalog proposes the encap-
sulate business objects refactoring solution (adapted
from ’encapsulate variable’ in [4]), as presented in table 4.
This refactoring solution suggests to route accesses to the
DBMS through dedicated data services; each of which
encapsulates all business objects required by one applica-
tion service. This structure reduces data visibility to only
those of the owned business objects, thereby preventing
unwanted interdependence between teams and services.

6. Discussion
In this section, we describe the extent to which the main
RQs (see section 1) of this study have been answered
through our finding and its demonstration; elaborate the
implications of the EA refactoring solutions identified
for researchs and practitioners; and identify the potential
threats to the internal and external validity of our result.

6.1. Explanation of the Result
With regards to answering the RQ1 and its sub-questions,
this study identifies the first catalog of EA refactoring so-
lutions for all the EA smells proposed in [2]. We achieved
this result by performing a conceptual transformation
on relevant code refactoring solutions, which relies on a
mapping between code and EA modelling concepts. To
document the resulting EA refactoring solutions, we use
a template of attributes which we adapted from some
existing templates in code refactoring domain. Finally,
we demonstrated the use of several refactoring solutions
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in some small scenarios of EA smell. While the solution
choices demonstrated may not be suitable to all cases in
reality, we believe that the presented catalog provides a
useful platform for EA researchers and practitioners to
develop new or better refactoring solutions to common
problems in EA.

6.2. Implication for Practitioners &
Researchers

Recent study in EA has proposed the concept of EA debt
[1] which represents the divergent EA evolution from
the EA standards and principles. One possible source of
EA debt is the implementation of sub-optimal solution
design. The role of EA smells is to indicate the signs of
existing sub-optimal solutions within the IT landscape,
so that further investigation can be triggered in time [2].

With regards to answering the RQ2, the implication of
our result can be seen from both practical and research
perspectives. For EA practitioners, the proposed EA
refactoring solutions may help to find possible methods
or techniques for solving the EA smells identified. Also,
such a solution catalog can help to establish common ter-
minologies within an organization, thereby supporting
various stakeholders to discuss possible solutions.

For the EA research community, our result gives mo-
tivation and food for thought for further investigations
into the concept of EA refactoring. Future attempts to
extend the catalog by transforming refactoring solutions
from other domains (e.g. process smell, infrastructure
smell, etc) may also adopt the conceptual transformation
methodology used in this study. To allow public contri-
butions in the development of EA refactoring solutions,
the catalog has been published in a website together with
a guideline on contributing [29].

6.3. Threats to Validity
The results of this study have to be seen in the light
of some limitations. In this section, we present an as-
sessment of possible threats to the internal and external
validity of our result. Internal validity focuses on the
reliability of the result within the given environment,
whereas external validity focuses on the ability to gener-
alize the result [32].

Internal Validity. The design of our methodology may
pose certain threats to the internal validity of our result.
Firstly, the code refactoring solutions analyzed were col-
lected from a selection of relevant books on code smell
and refactoring, thereby threatening the completeness
of the EA refactoring solution catalog. Secondly, the
mapping between UML and ArchiMate notations used
in the transformation was summarized from some se-
lected sources, thereby threatening the completeness of

the mapping used in this study. Last but not least, the pro-
cess of transforming code refactoring solutions into EA
domain relies on subjective analysis, which potentially
results in biased considerations upon deriving the EA
refactoring solutions. To reduce the bias, the resulting EA
refactoring solutions were reviewed and decided among
the authors of this paper. Despite these weaknesses, we
believe that the resulting EA refactoring solution cata-
log is a step in the right direction towards solutions for
common design issues in EA.

External validity. As the resulting EA refactoring so-
lutions are yet to be evaluated in industrial context, their
descriptions may still rather hypothetical and theoretical,
thereby posing challenges to their adoption. Further-
more, as there could be multiple solution alternatives for
every EA smell, further research is still needed to identify
possible factors and conditions which influence the suit-
ability of a certain EA refactoring solution. Finally, the
adoption of EA refactoring solutions greatly depends on
the progress in EA smell research. At the time of writing,
the existing EA smells are yet to be evaluated and their
descriptions enriched with practical examples.

7. Conclusion & Future Work
Our main goal is to support EA practitioners in analyz-
ing possible improvements with regards to the current
circumstances and interests. We strongly argue that ap-
proaches to EA improvement must extend from EA mod-
elling capabilities. Therefore, this study investigates the
concept of refactoring in the context of EA modelling.
Our methodology focuses on defining EA refactoring so-
lutions for the EA smells proposed in [2] by analyzing the
known associations between code refactoring solutions
and code smells. The resulting contribution is a catalog
of EA refactoring solutions which is publicly available
on a web page [29].

In spite of this progress, there is still work to be done,
especially in improving the catalog, or where further
work is necessary. Some potential future works in this
context are as follows: Firstly, further EA refactoring
solutions can be derived for EA smells from different
domains, such as the EA process smells [3]. For such
purpose, we suggest to adapt the methodology from the
one used in this study, e.g. by integrating a mapping
of ArchiMate to another modelling language of interest
as proposed in [16]. Secondly, empirical studies can be
performed to further review and improve the hitherto
knowledge in this area. Last but not least, tool supports
can be developed for, e.g., recommending suitable EA
refactoring solutions (e.g. [33]) or supporting the imple-
mentation thereof.
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